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1. La Biblioteca

y sus servicios. 

Guías por materia



La BUS es un magnífico sitio para 

empezar a investigar http://bib.us.es

Colecciones: Recursos de información de 

calidad, adecuados a las titulaciones que 

se imparten en la Universidad. 

¿Conoces nuestros servicios?

Biblioteca Filosofía y Psicología

http://bib.us.es/psicologia

Guías por materias. Psicología

http://guiasbus.us.es/psicologia

Guías para el investigador

https://bib.us.es/estudia_e_investiga/guia

s/investigacion

Web para postgrados:

http://bib.us.es/la_biblioteca_para/posgra

do

1. La Biblioteca y sus servicios

http://bib.us.es/
http://bib.us.es/psicologia
http://guiasbus.us.es/psicologia
https://bib.us.es/estudia_e_investiga/guias/investigacion
http://bib.us.es/la_biblioteca_para/posgrado


Sitio Web para posgrado

1. La Biblioteca y sus servicios

http://bib.us.es/la_biblioteca_para/posgrado
http://bib.us.es/la_biblioteca_para/posgrado


1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

Objetivo: ayudar a encontrar y 
gestionar información científica 
de calidad

Guías por materias. Psicología
http://guiasbus.us.es/psicologia

http://guiasbus.us.es/psicologia
http://guiasbus.us.es/psicologia
http://guiasbus.us.es/psicologia


• Catálogo de la BUS y 

otros Colectivos

• Bibliografía 

recomendada, 

novedades de Psicología

• Principales paquetes de 

libros-e para Psicología 

(acceso desde casa con 

el UVUS)

Pestaña Libros y más

Guías por materias en Psicología

http://guiasbus.us.es/psicologia

1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

http://guiasbus.us.es/psicologia


• Paquetes de revistas-e

suscritas más importantes 

para Psicología: 

Psycarticles…

• Revistas más importantes 

de tu área

• Acceso remoto: UVUS

• Más información

Pestaña Artículos, Revistas

Guías por materias en Psicología

http://guiasbus.us.es/psicologia

1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

http://guiasbus.us.es/psicologia


Pestaña Bases de Datos

Bases de Datos más importantes con guías, tutoriales…

Guías por materias en Psicología

http://guiasbus.us.es/psicologia

1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

http://guiasbus.us.es/psicologia


Pestaña Trabajos Académicos

• Consultar Trabajos 

Académicos…

• Bases de datos de TESIS…

• Bibliografía para crear 

trabajos académicos

• …

Guías por materias en Psicología

http://guiasbus.us.es/psicologia

1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

http://guiasbus.us.es/psicologia


Servicios de novedades 

bibliográficas y alertas. 

Tipos: 

• Alertas de sumarios de  

revistas

• Alertas de búsquedas

• Alertas de artículos citados

• Alertas de novedades 

editoriales

Pestaña Estar al Día

Guías por materias en Psicología

http://guiasbus.us.es/psicologia

1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

http://guiasbus.us.es/psicologia


Pestaña Sitios Web Pestaña Docimoteca

Guías por materias en Psicología

http://guiasbus.us.es/psicologia

Qué es, normas de consulta…

1. La Biblioteca y sus servicios: Guías por 

materia en Psicología

http://guiasbus.us.es/psicologia


2. Búsqueda de 

información

científica. Cómo buscar



¿Qué 
información 
busco?

Definir

¿Dónde?

Fuentes de 

información

¿Cómo la busco?

Técnicas 
Documentales 

¿Es de 
calidad?

Evaluar de 
forma crítica

La usaré de 
forma ética

Stop plagio

Citas y 
referencias

Gestores 
bibliográficos

Competencias 

informacionales

2. Búsqueda de información científica



2. Búsqueda de información científica. Concepto

La búsqueda de información es un proceso similar a un diálogo 

en el que hay que ir pasando por diferentes etapas hasta lograr 

un resultado satisfactorio.

 Cuanto más sistemática y planificada sea una búsqueda 

mejores serán sus resultados. 

 Requiere una metodología concreta antes y durante la 

ejecución.



Cuidadores Demencia Test

Enfermeros Alzheimer Cuestionario

Caregivers Dementia Medida

Valoración

Measurement

2. Define los términos de búsqueda:

 Desglosa las distintas ideas y conceptos.

 Busca palabras alternativas y sinónimos para cada uno de los términos. Para

ello nos podemos ayudar de herramientas como diccionarios especializados,

diccionarios bilingües, etc.

1. Pon por escrito tu necesidad de información

Ejemplo: Necesito artículos científicos sobre Cuidadores de pacientes

con demencia y donde se hayan empleado test

2. Búsqueda de información científica. Planificación



Catálogos

Identifican todos los documentos existentes en una determinada Biblioteca y también
dan acceso a los recursos electrónicos suscritos por la misma. Se pueden buscar los
libros y las revistas por su título, pero normalmente no se localizan los títulos de los
artículos de revista ni de los capítulos de los libros.

Bases de datos

Suelen ser productos comerciales o de instituciones, que recopilan información de
artículos de revistas, capítulos de libros, actas de congresos, etc. Tienen numerosas
herramientas de búsqueda y en muchas ocasiones dan acceso al texto completo.
Temáticamente hay bases de datos especializadas y multidisciplinares.

Buscadores de Internet
Buscan cualquier documento presente en la red pero sin tener en cuenta

previamente la calidad del mismo. Conviene usar buscadores específicos para el

mundo de la investigación científica como Google Académico.

2. Búsqueda de información científica. Dónde 

busco



- Catálogos 
(Fama+, CBUA, Rebiun, WorldCat …)

- Bases de datos:

• BD Especializadas : Psicodoc y Psycinfo
(Psicología), ERIC (Educación), PubMed
(Salud)

• BD Multidisciplinares: Dialnet, Scopus, 
Web of Science, Google Scholar

Fuentes de información

2. Búsqueda de información científica. Dónde 

busco



Acceder siempre a través de la página web de la Biblioteca

bib.us.es/psicologia

2. Búsqueda de información científica. Acceso a 

bases de datos de la Biblioteca



Cuando estemos fuera de la Biblioteca el sistema nos mostrará una pantalla

de acreditación para identificarnos como miembros de la Comunidad

Universitaria. Introduciendo nuestro uvus y contraseña podremos acceder.

2. Búsqueda de información científica. Acceso a 

bases de datos de la Biblioteca



Búsqueda simple: un casillero para escribir y a veces

algunas opciones para especificar algún aspecto como el

campo de búsqueda o limitar por texto completo

2. Búsqueda de información científica. Cómo 

busco



Búsqueda avanzada: múltiples casilleros y opciones, para hacer 
más concreta la búsqueda

2. Búsqueda de información científica. Cómo 

busco



Operador Ejemplo Recupera

AND/Y

publicidad

AND
autoestima

Todas las palabras

 Relaciona los 

términos y hace la 

búsqueda más 

específica

OR/O

Toxicomanía 

OR 

drogadicción

Alguna palabra
 Amplía la búsqueda

 Variantes de un 
término 

 Útil cuando el primer 
intento de búsqueda 
arroja pocos 
resultados

NOT/NO

Silencio 

NOT

administrativo

Excluye una palabra  Restringe la búsqueda

Relaciones lógicas entre los términos utilizando los operadores

2. Búsqueda de información científica. 

Operadores booleanos



2. Búsqueda de información científica. Otros 

operadores: truncados, comodines…

Otras utilidades Ejemplo

Adyacencia

” ”
Comillas

Un conjunto de palabras se busca 
como una frase exacta

Para recuperar un documento todas 
las palabras deben recuperarse en 

ese orden

”Organización de las Naciones 
Unidas”

Truncados

*,  $

El truncado sustituye una 

cadena de caracteres.

Nos permite buscar por la raíz 

de las palabras

Transex*

Recupera transexualidad, 
transexual, transexuales…

Comodín
?

El comodín sustituye un carácter Wom?n

Recupera tanto el término woman o 
women



Generalmente están en la búsqueda avanzada.

A veces se pueden usar con posterioridad a la 

búsqueda.

2. Búsqueda de información científica. Filtros



MUCHOS resultados…

• Añade sinónimos utilizando el 

operador OR

• Usa truncados

• Sustituye términos específicos por 

otros más genéricos

• Busca en todos los campos 

Evalúa los resultados obtenidos

2. Búsqueda de información científica

• Utiliza los filtros

• Añade conceptos usando AND para 

concretar la búsqueda

• Elimina términos genéricos  que aporten 

muchos resultados

• Elimina truncados

• Busca en campos específicos

POCOS resultados...



Administrar (Grabar, imprimir, enviar, mandar a un gestor 

de referencias, crear alerta, …)

 Acceder al documento original

Texto completo

Gestionar las referencias bibliográficas

Guarda, envía por correo-e…

2. Búsqueda de información científica. 

Administra los resultados

https://www.google.com/url?q=http://www.publichealthsystems.org/endnote-library.aspx&sa=U&ei=odSFU9PAGuia0QW68oGYDw&ved=0CDYQ9QEwBDgo&usg=AFQjCNHg9F31RylYpjXwrus7WtukNuSSHA
https://www.google.com/url?q=http://www.publichealthsystems.org/endnote-library.aspx&sa=U&ei=odSFU9PAGuia0QW68oGYDw&ved=0CDYQ9QEwBDgo&usg=AFQjCNHg9F31RylYpjXwrus7WtukNuSSHA


3 .Principales recursos: 

Multidisciplinares y especializados:

Dialnet,ERIC

PsycINFO, WOS, 

Psicodoc



Fruto de la colaboración de 55 Bibliotecas 
Universitarias españolas (entre ellas la BUS)

La mayor hemeroteca de artículos científicos 
en español en Internet. Centrada 

fundamentalmente en los ámbitos de las 
Ciencias Humanas, Jurídicas y Sociales

5.000.000 millones de documentos  pueden 
consultarse en Dialnet, entre ellos 

encontramos artículos de revistas, capítulos 
de libros, tesis doctorales, etc. Un gran 
porcentaje de estos documentos están 

disponibles a texto completo.



Acceso directo a través de Web:  

http://bib.us.es/psicologia

Aparece el registro en el 

catálogo Fama y accedemos al 

recurso

3. Principales recursos. Dialnet: acceso

http://bib.us.es/psicologia


• Si entramos en Dialnet dentro de la red 

Informática de la Universidad, podremos utilizar 

casi todas las funcionalidades sin necesidad de 

registrarnos

• Si entramos desde fuera de la Universidad, es 

conveniente que nos registremos para acceder 

a determinados servicios de Dialnet+:  filtros, 

búsqueda avanzada, alertas, guardar 

búsquedas, crear listas, etc. 

3. Principales recursos. Dialnet: acceso



Búsqueda básica:

Búsqueda avanzada: 

título, autor, 

contiene, fecha de 

publicación… 

Vamos a hacer una 
búsqueda básica:

“Violencia familiar”

3.  Principales recursos. Dialnet plus: búsquedas…

5 buscadores específicos: 

documentos, autores, revistas, 

congresos y tesis



Filtros para 
acotar la 

búsqueda

Los documentos encontrados 
pueden ofrecer el resumen o 
el texto completo

Puedes 
seleccionar para 
visualizar 
posteriormente

3. Principales recursos. Dialnet plus: resultados



… para importar a Mendeley
seleccionar los registros deseados 
y en Enviar/ Exportar, generamos 
un fichero RIS 

3. Principales recursos. Dialnet plus: 

Importar a Mendeley



3. Principales recursos. Dialnet plus: Alertas

Para crear alertas es necesario estar registrado



Dialnet plus: Aprende por tu cuenta

https://dialnet.unirioja.es/info/ayuda/indice
https://dialnet.unirioja.es/info/ayuda/indice


3.  Principales recursos. Dialnet plus: 

operadores booleanos



ERIC es la base de datos más importante en el 
mundo de la Educación.

Incluye más de 700.000 citas de artículos de 
revistas, informes técnicos, descripción de 

programas y materiales curriculares desde 1966.

ERIC ofrece cobertura de artículos de revistas, 
conferencias, reuniones, documentos 

gubernamentales, tesis, disertaciones, informes,       
medios audiovisuales, bibliografías, directorios, libros 

y monografías.

Incluye además artículos a texto completo

Periodicidad mensual



Accede a través de la 
Guía de Psicología o 
Fama. Acceso desde 
casa con el Usuario 
Virtual (UVUS)

3. Principales recursos. ERIC: acceso



3. Principales recursos. ERIC, PsycINFO

Proquest es un paquete de 
base de datos que incluye 
hasta 24. bases de datos: 
PsycINFO, ERIC, MEDLINE….



3. Principales recursos. ERIC, PsycINFO…

Guía de Proquest: 
http://www.apa.org/pubs/data
bases/training/proquest-qrg.pdf

http://www.apa.org/pubs/databases/training/proquest-qrg.pdf


El sistema buscará el termino introducido en los campos:
autor, título, resumen y materia.

Permite Operadores Booleanos, comillas y truncados

3. Principales recursos. ERIC: búsqueda simple



Se pueden refinar los resultados a 
través de diferentes opciones. Se 
podría ejecutar una segunda 
búsqueda sobre los resultados 
obtenidos

3. Principales recursos. ERIC: filtrar resultados



3. Principales recursos. ERIC: ver texto completo



Diferentes formatos 
del documento (variará 
según el registro)

Para ver más 
documentos de la 
misma temática 

Para buscar  otros 
documentos con los  
mismos términos de 
indexación que el 
documento abierto

3. Principales recursos. ERIC: ver texto completo



Información sobre los campos

3. Principales recursos. ERIC: búsqueda avanzada

Hacer estrategias, delimitar 
y buscar por campos, filtrar, 
utilizar los índices y muchas 
más opciones de búsqueda

http://0-search.proquest.com.fama.us.es/help/academic.es-ES/webframe.html?psycinfo_field_codes.html


Añadir filas, usar operadores 
booleanos, tesauro, nuevos filtros… 

Y con el resultado…

3. Principales recursos. ERIC: búsqueda avanzada



3. Principales recursos. ERIC: Exportar a Mendeley

Seleccionamos aquellos 
documentos de nuestro interés y 
en Guardar , creamos un fichero 
RIS para enviar a Mendeley



PsycINFO: Base de datos de la APA que ofrece 
información sobre Psicología y otras ciencias 

relacionadas con ella

Casi 4. millones referencias y resúmenes de libros, 
capítulos, tesis y artículos de revistas de más de 50 

países.

Más de 2.500 revistas, 99% peer-reviewed

PsycINFO es el principal punto de acceso a la 
literatura académico-científica publicada a nivel 

internacional desde  1967 hasta el presente

Actualización: semanal

Al ser una base de datos internacional hay que 
buscar en inglés



Acceso directo a través de Web:  
http://bib.us.es/psicologia

Aparece el registro en el 
catálogo fama y accedemos al 
recurso

Desde casa hay que insertar el 
Usuario Virtual (UVUS)

http://bib.us.es/psicologia

3. Principales recursos. PsycINFO: acceso

http://bib.us.es/psicologia
http://bib.us.es/psicologia


3. Principales recursos. PsycINFO: tesauro

Antes de realizar una búsqueda por materias, puedes  
consultar el Tesauro (lista de palabras admitidas para 
determinar la materia del documento). 

Acceso al Tesauro a través de Búsqueda avanzada.



Un descriptor es cada uno de los términos
escogidos entre un conjunto de sinónimos
para representar (en calidad de término
preferido) generalmente de manera unívoca,
un concepto susceptible de aparecer con cierta
frecuencia en los documentos indizables, y en
las consultas que se realicen

El tesauro es un vocabulario controlado de 

términos y sus relaciones (jerárquicas, asociativas 

y sinónimas)

Búsqueda por materias / descriptores : campo

muy interesante para la búsqueda de información 

especializada. Nos remitirá a la materia dentro de 

un índice uniformado 

3. Principales recursos. PsycINFO: tesauro



3. Principales recursos. PsycINFO: tesauro

Utiliza un lenguaje controlado que nos evita tener que pensar 
en todos los términos que identifican a un concepto. 

Introducir el término en el cajetín o buscar en el listado 
alfabético

Explode: para buscar el 
término en su área de 
conocimiento .

Major: para buscar ese 
término como materia 
principal



3. Principales recursos. PsycINFO: alertas, 

guardar búsquedas….

Permite guardar los 
resultados de una 
búsqueda, crear alertas, 
crear RSS…

Exporta a Mendeley los 
resultados de tu búsqueda 
con un fichero RIS



El Web of Knowledge es una plataforma que integra 
los siguientes productos: Web of Science, ISI 

Proceedings, Derwent Innovations Index, Journal
Citation Reports, ISI Essential Science Indicators y 

Current Contents Connect. Se puede acceder a ellos 
de forma individual o haciendo una búsqueda 

simultánea a través de CrossSearch

ERIC.

Área de Ciencias Sociales, Humanidades, Tecnología, 
Ciencias sociales…

Profesores, investigadores, estudiantes matriculados y 
personal de la Universidad de Sevilla 

Acceso mediante dirección IP



3. Principales recursos. Web of Science: acceso

Acceso directo a través 
Fama http://fama.us.es/

Si entramos desde casa nos pedirá el UVUS

http://fama.us.es/


3. Principales recursos. Web of Science (WOS)

Realiza la búsqueda en todos los productos a 
los que esté suscrito de forma simultánea o, 
selecciona una base de datos



3. Principales recursos. Web of Science (WOS)

Una vez realizada la 
búsqueda, puede 
ordenar los 
resultados por  Veces 
citado- de mayor a 
menor frecuencia

Para ver las citas que 
tiene un artículo,  ver 
el impacto de una 
revista



Base de datos elaborada por la 
Facultad de Psicología de la 

Universidad Complutense y el 
Colegio Oficial de Psicólogos de 

Madrid. 

Reúne referencias bibliográficas de    
artículos, actas de congresos, libros 
y literatura gris sobre Psicología y 
disciplinas afines, procedentes de 

España y América Latina desde 
1975 hasta la actualidad. 

Incluye resúmenes en castellano e 
inglés y acceso a texto completo. 

Se actualiza mensualmente. 

Acceso restringido



3. Principales recursos. Psicodoc: accede a 

nuestra guía 

https://guiasbus.us.es/Psicodoc/Introduccion?preview=02974c75d2326e923d72175346d31f77


4.Gestor de 

referencias

bibliográficas Mendeley



Una vez realizada las búsqueda y tras obtener y evaluar la 

información, incluyendo y excluyendo resultados con nuestros 

criterios, procederemos a redactar nuestro trabajo de 

investigación

En este momento, será fundamental que reflejemos las fuentes 

empleadas sean libros, artículos, periódicos, páginas web…

Si no citas, incurres en una falta de honestidad académica y 

es contrario a un uso ético de la información

En la Biblioteca tenemos los manuales de la APA, guías y 

también están los gestores que ayudan a elaborar citas y 

referencias

Sin plagio en tu TFM



Recuerda: Cita y Referencia



Contenidos

• Qué es Mendeley

• Cómo crear una cuenta

• Conoce Mendeley Web: Interfaz

• Accede a Mendeley Institucional

• Descarga  Mendeley Desktop (escritorio)

• Prepara tu PC: Instala plugin, Web Importer

• Mendeley Desktop (escritorio): Interfaz

• Opciones de importación: directa e indirecta

• Organiza documentos y referencias. Trabaja con los pdfs

• Cita y crea tu bibliografía



Qué es 
Mendeley

Guarda 
documentos de 
forma eficiente

Crear citas y 
bibliografías en 
diversos estilos

Espacio de 
colaboración 

para grupos de 
investigación

100 millones de 
documentos que 

reciben 100 
millones de 

visitas al mes

Ayuda a 
conectar 

investigadores

4. Gestor de referencias bibliográficas: 

Qué es Mendeley



4. Gestor de referencias bibliográficas:

Qué es Mendeley



Desktop Web 
Mobile 

Software académico gratuito

Compatible con todos los sistemas 

operativos (Win/Mac/Linux/Mobile)

Principales navegadores

4. Gestor de referencias bibliográficas: 

Qué es Mendeley



La versión institucional ofrece mayores ventajas,

tanto en la capacidad de almacenamiento, como en la

creación de grupos.

Cuenta además, con soporte técnico, 

tanto de Mendeley como de la BUS

4. Gestor de referencias bibliográficas:

Mendeley Institucional



http://mendeley.com

4. Gestor de referencias bibliográficas:

cómo crear una cuenta
¡Para crear tu 
cuenta, utiliza el 
correo institucional!

http://mendeley.com


Buscar documentos, personas, grupos

Editar perfil, privacidad, ayuda, 

descargar Mendeley, salir…

Library, réplica web de 
Mendeley Desktop 

(escritorio)

Grupos

4. Gestor de referencias bibliográficas:

Mendeley web: Interfaz



4. Gestor de referencias bibliográficas:

Descarga Mendeley Desktop



Web Importer:

Para importar referencias de la web

MS Word Plugin

Open Office Plugin

Permite citar y generar bibliografía 

desde nuestro procesador de texto

4. Gestor de referencias bibliográficas:

Instala plu-gin, Web Importer

Ya hemos descargado el programa en www.mendeley.com

Seguimos preparando nuestro ordenador

http://www.mendeley.com/


4. Gestor de referencias bibliográficas.

Mendeley Desktop: Interfaz

1.- My 

library:  

carpetas, 

grupos, 

buscar…

2.- Sync: 

Actualice

antes de 

cerrar…

3.- Referencias: Haga doble click en un 

documento y abra el visor PDF

4. .- Details: 

editar metadatos, 

añadir notas

5. Search:  

autor, título, 

publicación



- Añadir archivos guardados en el ordenador

- Añadir carpetas con documentos de

nuestro ordenador: arrastrar pdf.

- Añadir automáticamente todos los archivos que 

vamos guardando en una carpeta concreta de 

nuestro ordenador: carpeta monitorizada

- Añadir entrada manualmente.

4. Gestor de referencias bibliográficas. 

Opciones de importación: directa e indirecta

- Usar el Web Importer.

- Añadir ficheros en otros formatos: RIS, BibTeX



4. Opciones de importación: pdf

… Mendeley extraerá los datos de 
los documentos automáticamente.

Si se añade un PDF 
directamente…



4. Otras opciones de importación: arrastrar pdf

Arrastrar los pdfs desde su ubicación
hasta el escritorio de Mendeley



4. Otras opciones de importación: 

carpeta monitorizada

Desde File / Watch a folder se pueden importar de 
forma automática los PDF que se depositen en la 
carpeta seleccionada. Se convertirá en carpeta 
monitorizada : todo lo que se guarde en esta carpeta 
se volcará en Mendeley



4. Otras opciones de importación: 

manual en File > Add Entry Manually

Introduzca el 
DOI, PubMed
o ArXiv ID y 
localice la 
referencia

http://dx.doi.org/10.1111/j.14. 71-184. 2.2007.00701.x



Para crear una nueva carpeta sólo hay 
que hacer clic y asignarle un nombre.

4. Organizar documentos y referencias 

importadas

Si seleccinamos un documento, 
apareceran sombreadas las distintas
carpetas en las que está almacenado



Y selecciona Remove from folder.

… y selecciona Remove from Folder

Para quitar un documento de una
carpeta, haz clic sobre el documento, 
botón derecho…

4. Organizar documentos y referencias 

importadas



Se puede vaciar la papelera pulsando
Empty o volver a agregar un documento a 
la biblioteca pulsando Restore.

Trash, es la papelera y es a donde van 
a parar los documentos que 
eliminamos. Una vez borrados de esta
carpeta, no se podrán recuperar

4. Organizar documentos y referencias 

importadas



Cuando una referencia tiene el 
documento en PDF, podemos visualizarlo 
y trabajar con él sin salir de Mendeley.

El icono nos indica que el PDF está 
disponible en esta referencia.

4. Trabajar con documentos: subraye

y anote los pdfs



Subraya y añade anotaciones 
con el visor de pdf

Busca tus propias 
notas

4. Trabajar con documentos: subraya

y anota los pdfs



Mendeley permite hacer citas bibliográficas 
automáticamente en nuestros documentos

Antes de crear la bibliografía, comprobamos en qué estilo se 
visualizarán:
En View > Citation Style nos aparece una lista de los estilos 
más utilizados. Use More Styles para elegir otros estilos

4. Cita y crea tu bibliografía



Una vez instalado el 
plugin, al abrir Word en 
Referencias, aparecerá un 
nuevo menú, Mendeley 
Cite-O-Matic

4. Cita y crea tu bibliografía

Para insertar una cita, 
pulse Insert Citation.

Busca en Mendeley el document que vamos
a citar, Go to Mendeley > Selecciona > Cite



4. Cita y crea bibliografía

Una vez insertadas todas las citas, para 
crear la bibliografía, coloca el

cursor donde quiera que aparezca y

pulsa en Insert Bibliography



4. Cita y crea bibliografía

Desde Word en Style, si necesita
s cambiar el estilo de citas.

Si no lo ves, haga click en 

Select > Other Styles



Las citas se pueden 
editar, selecciona la 

cita... 

... pulsa sobre ella y utiliza el 
editor para añadir páginas ...

4. Cita y crea bibliografía



Sincronizar

¡No olvides sincronizar tu biblioteca antes de salir de Mendeley Desktop…

… actualizará los datos y podrás trabajar en ella desde cualquier otro dispositivo!



http://guiasbus.us.es/mendeley

Guía de la BUS

http://guiasbus.us.es/mendeley
http://guiasbus.us.es/mendeley
http://guiasbus.us.es/mendeley


Guías de la BUS: Evita el plagio



Citando en APA



5. IDUS: repositorio

institucional

de la US



GESTIÓN 

INFORMACIÓN 

DOCTORANDOS
– 2.6 Guía de Mendeley

5. IdUS: Depósito de Investigación de la US



GESTIÓN 

INFORMACIÓN 

DOCTORANDOS
– 2.6 Guía de Mendeley

5. IdUS: Depósito de Investigación de la US



Más información en http://guiasbus.us.es/idus/

TFG/TFM con Sobresaliente o Matrícula

http://guiasbus.us.es/idus/


GRACIAS POR VUESTRA ATENCIÓN

http://bib.us.es/psicologia

http://bib.us.es/psicologia

